Life after Autodesk® Revit®

Primary Speaker: Mark Cronin - Peddle Thorp Architects
Co Speaker: Paul Listo – Peddle Thorp Architects

AB5005-P: Flex the muscles of your Revit model by using multiple Autodesk applications to boost your team’s productivity and improve the range and quality of your deliverables. This class guides you through the process of using 10 different Autodesk applications on real projects, starting with the Autodesk Building Design Suite and then adding applications from Autodesk Labs. Discover how to gain more from your building information model by seamlessly exchanging data between applications while avoiding common problems. You will learn how to improve your company’s workflow and maximize the quality and scope of your deliverables, from conceptual design through to building management. Explore the range of data-rich information available for communicating with your client. Find out how recent developments in design tools have affected architectural workflow and what the consequences are for your team. Realize the potential of maximizing your workflow strategy to benefit your business.

Learning Objectives
At the end of this class, you will be able to:

- Use your existing Revit models in different applications to deliver more professional results
- Identify the key applications required to improve the range and quality of your deliverables
- Develop a workflow strategy for your business that utilizes multiple applications
- Determine who has the skills and is best suited to deliver this additional content

About the Speaker
Mark holds a Bachelor’s of Science in Architectural Technology. He is employed as Design Systems Manager at Peddle Thorp Architects in Brisbane Australia, and is tasked with maximising the efficiency of BIM within the company. Mark was recruited from the UK where he previously worked as 3D Application Specialist at a top-five multidisciplinary design consultancy. He has been responsible for providing in-house training and mentoring for several Autodesk® applications across multiple disciplines. He has applied his working knowledge of more than a dozen design applications to many projects across various sectors for a broad range of clients.

m.cronin@peddlethorp.com.au
Introduction

Many architectural firms have made the transition to Autodesk Revit, some more successfully than others, but what happens after all the processes are in place and construction drawings are being produced effectively? What do you do next? Yes, sure the ever expanding library of families has to be managed but there must be something else. It often seems there are increasing variations to workflows that can be implemented to ensure that you are making the most of the Information in BIM. But what about the use of that Information outside of Revit?

This lecture will highlight some of the options available to you, to help you maximize the use of the inherent data contained within your Revit models. It will consider use of the Building Design Suite and introduce a selection of other applications. Their application will be considered, along with the ease of data exchange, giving you step-by-step instructions on how to get the data out of Revit and into these additional programs. This handout acts as a guide, conveying best practice and viable solutions to common obstacles encountered during the transfer of Revit data. Please view the lecture screen capture or PowerPoint for more real-world examples and commentary.

What, Why, Who? (At least you know where!)

Firstly, you need to consider why your firm would want to incorporate a more comprehensive workflow; after all, the additional time put into producing extra deliverables is going to cost.

- Will you see additional returns, how do you justify the costs?
- What benefits can the use of supplementary applications bring?
- Can you charge more for additional deliverables?
- Will it help to win new clients, or are clients just expecting more?
- Can you reduce the cost of consultants by doing some of their work?
- Does your team possess the necessary skills?
- Do you have access to the required resources?

These are just some of the questions that need considering before you decide what you are willing to take on. Perhaps you are planning to extend your firm’s workflow dramatically in an attempt to bring several of your currently outsourced processes back in-house, or maybe you are just considering adding in one or two applications to increase the productivity of your team. Either way, hopefully you will get something useful from this lecture.

Life after Revit

Some of these applications are programs that you may have previously used day in and day out, such as AutoCAD, and will therefore be skimmed over only mentioning how they fit into some suggested workflows. However, others are still in the research phase, or are available as technology previews only. All of these applications have the potential to extend your range of deliverables or at the very least improve the quality of work you produce.
1. Autodesk® SketchBook® Designer

SketchBook Designer is a combined vector and raster sketching tool that is intended as the software platform answer to the requirement for conceptual sketching. The most noteworthy feature of SketchBook is that it allows vector based information to be exported to DWG which could then be linked into Revit or imported into other software applications.

Views or sheets in Revit can be exported to DWG (as per Section 2) and opened within SketchBook. Within AutoCAD, navigate to the SketchBook Designer tab on the ribbon where you can create a New Canvas, link to Sketchbook Designer and view help files.

This workflow opens new alternatives when presenting graphical information to clients. Plan, elevation and section views can be exported to DWG and opened in SketchBook through AutoCAD where you can set the canvas extents and initiate the link. You can alter the appearance of vector lines and add color to create a more conceptual feel to drawings. 3D models are not compatible with this workflow as they cannot be imported by SketchBook, however 2D perspectives can, so just export (to DWG) your preferred views from sheets. PDF and image files generated out of Revit can also be imported as an underlay and sketched over in SketchBook to give a hand drawn appearance.

2. **Autodesk® AutoCAD®**

This is not really a topic that fits with *Life After Revit*, but seeing as we are looking at AutoCAD it is worth a mention. There is always a need to *link* (not insert!) AutoCAD drawings into Revit models to allow information in a DWG format to be utilized.

1. Insert Ribbon tab → Link panel → Link CAD
2. Specify the Colors, Layers, Import Units, Positioning, and whether you want the DWG to be visible in the current view only ([further information here](#))
3. Click Open.

There aren’t any secrets here, everyone must have done it at some stage, and in my experience the most common problem is when things don’t show up. 100% of the time the DWG is there, you just can’t see it. Check the view visibility settings, the crop view settings, the import scale, and ensure the correct positioning option for starters.

Even firms that converted to Revit years ago will undoubtedly have an occasional need for AutoCAD, even if it’s just to verify DWG output for delivery to clients or contractors;

1. Application Button → Export → CAD Formats → DWG files.
2. Select or create an Export Setup.
3. Specify your export options as required. (Spend time customizing these fields to meet your company standards - Check out [DWG Export Options](#)).
4. Specify the views or sheets to export and click next. (Again, setup commonly exported sheets/views as sets).
5. Select the file type and naming option.
6. Uncheck (in most cases) the export views on sheets as external references option (or change the default setting on the General tab of the Modify DWG/DXF Export Setup dialog).
7. Click OK and you’re done.
There are still a few other things that AutoCAD can come in useful for, even with a good Revit workflow in place. This is mainly the quick cleaning up of DWGs (refer to Impression section) or the different ways of exporting other file types (refer to 3D Printing section). There are also some very clever minds producing some amazing work in good old AutoCAD too, just check out Robert Aish’s lecture; *DesignScript: Associative, Parametric, and Computational Design within AutoCAD®*. No matter how pro Revit you are, I still don’t think AutoCAD will be retiring any time soon.
3. Autodesk® Revit® Conceptual Energy Analysis | Autodesk® Green Building Studio® | Autodesk® Ecotect® Analysis

Awareness of green or sustainable design is no longer enough, you need to be actively participating. There are several Autodesk applications that can contribute to your workflow in this area and there is some overlap between them. If you haven’t really looked into these products it might be a bit confusing trying to decide which product to use when, so let’s start at the beginning.

Revit Conceptual Energy Analysis (CEA) was introduced as a subscription benefit last year, which allows you to perform energy analysis on mass models directly from within the Revit Project Environment. It is designed for use with very early stage massing models with mass floors and glazing areas. Calculations are carried out in the cloud and you are notified when the results are ready.

1. Within Revit set the project location (Manage Ribbon tab → Project Location panel → Location).
2. Create your mass model and add mass floors (refer to Creating a Mass Family).
3. Create the Energy Model (Analyze Ribbon tab → Energy Analysis panel → Energy Settings)
4. Adjust the settings as required (Energy Model Settings)
5. Click Analyze Mass Model (Analyze Ribbon tab → Energy Analysis panel → Analyze Mass Model) –sign in to Subscription Centre required.
6. Specify a name for the mass and click continue
7. An alert pops up when the analysis is complete and you can compare the results, (Analyze Ribbon tab → Energy Analysis panel → Results & Compare).
Your mass object requires mass floors for Revit to perform energy analysis calculations. Any mass object without mass floors will be considered a shading object. As a side note; the results from CEA should be very similar to any analysis results from Vasari, as they both utilize the Green Building Studio engine to perform the calculations.

Keep your model simple, convert curves to facets and simplify your geometry. During conceptual energy analysis, Revit can analyze the following maximum numbers of surfaces, openings, and spaces:

- Exterior surfaces: 8192
- Interior surfaces: 8192
- Underground surfaces: 8192
- Shade surfaces: 1024
- Openings: 8192
- Spaces: 4096

For more tips checkout Best Practice for Conceptual Energy Analysis and the Revit Conceptual Energy Analysis Videos.

Project Vasari (2.1) should also get a mention here. It is not really addressed in this lecture due to the application being more suited to a pre-Revit workflow, but it should be seriously considered as an alternative to CEA. Due to Vasari being a Technology Preview it is developing and evolving a lot faster than CEA can, therefore, it has a great UI and several cool additional features that are well worth checking out. Take a look here for further information.

The next step up is to try the Green Building Studio (GBS), a web based service that is available to subscription customers. It utilizes rooms/spaces via gbXML exports, as opposed to mass based analysis, therefore it is more suited a further developed design. This method requires more information to be entered upfront but in return you get more detailed and accurate results.

Exporting to the Web Service from Autodesk Revit Architecture and MEP;

1. Export a gbXML file (Application Button → Export → gbXML)
2. From your computer's start menu, launch the Green Building Studio Desktop client.
3. Enter your Autodesk ID and Password and click the Sign In button. You must be connected to the internet for this to work.
4. If you have projects in your Green Building Studio account, they are listed in the Project list. Simply select the project to which this model is assigned.
5. Select the gbXML file you exported from Revit.
6. Click Create New Run to initiate the simulations and get results.
The web-based service first checks your Revit model for missing data or errors, and if problems are found, an error message appears. Assuming there are no errors, a browser window opens presenting you with the status of your whole building energy, water, and carbon analysis.

There are several issues to watch out for when exporting gbXML files from working Revit models:

- Ensure that volumes are enabled and areas are calculated from the wall centers (Home Ribbon tab → Room and Area dropdown → Area and Volume Computations → Area and Volumes + At wall centre).
- Ensure that rooms (and their limits and offsets) are correctly placed within a properly enclosed region.
- Make use of the Export gbXML - Settings dialogue box preview window. On the Details tab, select the Rooms option to check the volumes and the Analytical Surfaces option to check the geometry. Resolve any problems before proceeding.

Again, keep your model simple! For complex projects you may be better off creating a separate file that can be dumbed down. Simpler geometry will lead to fewer errors with your export and will take less time to analyze. For further guidance look here.

Ecotect is at the top of Autodesk's range of sustainable design tools and requires additional licensing as opposed to being bundled with suites for subscription customers. The key differences between Ecotect and GBS are seen below.
A combination of both tools should meet the needs of most users, however with gbXML you can always make use of other energy analysis software as this file type is accepted as an industry standard for exchanging energy simulation data.

The gbXML files can be loaded into Ecotect by navigating to File → Import → Model/Analysis Data → select gbXML from the dropdown menu and select the file you wish to open.

Another alternative, if you are using third party analysis software, is to use their plugins. IES (Integrated Environmental Solutions) has a free plugin (http://www.iesve.com/software/ve-ware) that can often produce a better result when exporting more complex models.

Even if you don’t do the analysis in-house, you may be able to reduce the costs you incur and speed up the delivery of your results by providing an accurate working model to your consultants. There is further information available from here and a great overview whitepaper too.
4. 3D/2D ShareNow | Project Freewheel® | Project QuickShare | eTransmit for Revit®

These technology previews are related because they revolve around the informal sharing of data. Let’s break it down;

**3D/2D ShareNow** is a technology preview designed as a plugin to enable you to publish DWF files from within Revit (and other applications) to the Project Freewheel server. It is intended to bring you all the benefits of Freewheel (see next section) without needing to install any additional software. There’s not much in the way of settings to tweak here though, just download, install and click the *ShareNow* button on the *Add-Ins* ribbon tab.

In Revit 2012 there have been some issues with installation. On some workstations the user’s `revit.dll` (located on Win7 PCs at `C:\Users\<username>\AppData\Roaming\Autodesk\Revit\Autodesk Revit Architecture 2012`) wasn’t receiving the necessary information. The dll should include the following lines;

```ini
[ExternalApplications]
EACount=1
EAName1=ShareNow
EAClassName1=Autodesk.Freewheel.RevitAddin.ShareNowApp
EAAssembly1=C:\Program Files (x86)\Autodesk\ShareNow\RevitShareNow2011Plus.dll
EADescription1=Share Now
```

(If `EACount=1` already exists, 1 should be substituted with the next sequential number as required)

3D/2D ShareNow is an easy way to share your model, either a single view or multiple views (including sheets) with just one click.

**Project Freewheel** makes use of your web browser via a dedicated website to collaborate informally across project teams. You can use 3D/2D ShareNow to automatically upload a DWF and then start a session that can be password protected. You can send emails with embedded links as required. It has similarities to Design Review, allowing markups but also has real time session sharing. This is great for being able to host meetings across distributed teams. DWF files can also be embedded into web pages.
1. While working on a design using AutoCAD, Inventor, or Revit, click on the ShareNow icon.
2. Log into Autodesk Labs.
4. Email links to join or verbally instruct telephone participants to navigate to http://freewheel.labs.autodesk.com, select Share → Join, and enter the session name.

Manage sessions via the folder dropdown (top left) and scroll through the views using the dropdown menu or left/right arrows (top right). Note that Mozilla Firefox® and Microsoft Internet Explorer® are the only supported browsers and there is a 15MB file size restriction.

**Project Quickshare** is another technology preview aimed at sharing DWF files from anywhere, at any time, for free. It uses Autodesk’s cloud and your browser, much the same as Project Freewheel. It lacks some of the capabilities, such as creating markups, but is simple to use. It does incorporate some features from Design Review such as displaying properties, and the quality of image is slightly better than Freewheel, at the expense of speed. More importantly, no software other than your browser and a DWF file is required, making it very accessible. However, it is probably not necessary for larger businesses, as it is unlikely that you will have a DWF on a PC without the software required to make use of a more effective solution. I am sure these features will find a place somewhere in the cloud, perhaps associated with mobile devices?

Quickshare really is very quick and easy to use, just open your internet browser (most mainstream browsers are now supported) with an active internet connection. Type quickshare.labs.autodesk.com and click the Upload button, and you’re away.
eTransmit for Revit®

Another lab’s Technology Preview, eTransmit for Revit is easy to download and install. The Transmit a model button appears on the Add-Ins Ribbon Tab the next time you open Revit.

This is a great feature for archiving models at various stages throughout a project. It pulls all of the associated files together into one folder (with some exceptions!). It is also intended to be used for collaboration purposes, making a complex model with linked files and DWGs easier to share between disciplines.

1. Open Revit but have NO projects open.
2. Add-Ins Ribbon Tab → eTransmit → Transmit a model.
3. Select the model and target directory.
4. Check the files to validate (important step if archiving).
5. Autodesk® Cloud

Autodesk Cloud offers benefits to subscribers. The benefits include Online Storage, Rendering, Optimization, Collaboration, and Energy Analysis. Which services you are eligible for depends on which products you have on subscription. There is a more detailed breakdown here highlighting the entitlements.

All accounts have access to the Storage, Sharing, and Viewing of documents on the Cloud. This also includes DWG editing and Mobile Viewing. 1GB of storage per account is allocated, with 3GB per seat for subscription customers, but this actually equates to 3GB per user (with an initial limit of 6 end users per account). End users have to be assigned by the contract manager and must verify their subscription to be able to access the features of the Cloud.

Autodesk Cloud Documents is accessed through http://documents.cloud.autodesk.com, visit now to get started uploading and sharing your documents. Additional help is available from Autodesk Cloud Document Help. Cloud Documents also contain tracking, sharing, and review features. This platform hosts the documents for mobile access too, through AutoCAD WS and...
Design Review Mobile. While a bit fiddly to use on a phone, they perform well on tablets. This area of mobile apps will only continue to grow, with SketchBook® Mobile X and SketchBook® Mobile already available. Maybe a Revit family editor next…please?

Other benefits include Cloud Rendering, accessed from http://rendering.cloud.autodesk.com. Alternatively, you can access the service directly through Revit (a plugin can be download after your initial sign in). There are limits imposed of 100 cloud credits per seat of eligible subscription, per year. One credit equals one render. Rendering on the cloud is a great benefit if you have architects who like to render images in Revit. Uploading rendering to the Cloud removes the workload from local workstations and frees up a Revit license for someone to use. Further information can be found here.

Simply navigate to the Online tab of the ribbon, and select Render in Cloud from the Rendering panel.

Optimization for Autodesk Inventor is coming soon. It too will be subject to the same 100 cloud credits limitation.

Other applications powered by the cloud include the energy analysis applications; GBS and CEA, which have been mentioned in Section 2.
6. Autodesk® Impression 3

Impression is really popular with our architects due to the sketchy artistic styles that can be quickly and easily produced. Plans and perspectives in DWG format can be transformed into a presentation material that has a hand drawn look and can easily convey the architectural intent in a loose or flexible manner. It is really quick and easy to get good results from Revit and it can be tackled by anyone. It is a free download if you have subscription to certain software, but it hasn’t been updated for a while and can be very temperamental, so save often, especially when using fills.

1. Set the Visibility/Graphics of the sheet you wish to beautify to hidden line.
2. Export a DWG file (Application Button → Export → CAD Formats → DWG files).
3. Open Impression and create a new file, sized as required.
4. Import the exported DWG and follow the prompts.

Styles can be applied to the line work and styled fills applied to bounded areas. Try applying a wiggle pen style to the line work when importing and then save out to a PSD, open in Adobe® Photoshop® and blend with other versions of the sheet printed from Revit.

Use the Visibility/Graphics controls to set the ambient light, enable shadows, etc., and print the sheet to PDF before combining with the impression image in Photoshop. You can even include rendered images, play around with layer controls, just remember to have the line work layer on top.

Or you can go for the more artistic Impression option; painting up your image using the fill tools and adding various blocks such as trees within Impression. If you experience stability issues try cleaning up your DWG, removing any short lines and unnecessary detail and import again.

Impression is very capable of producing great looking sketchy images in a short time scale. It can be easily incorporated into most existing workflows too, making it a good starting point for adding extra value to your existing process.
7. Autodesk® Showcase®

Showcase was previously an automotive/product design real-time visualization tool. The Project Newport technology preview (real-time application for Revit) fed into Showcase 2012 and it is now marketed as real-time 3D presentation and rendering software for digital prototyping and architecture. While it’s not capable of importing a native Revit file, it is fully compatible with FBX files exported from Revit. The import process generally goes quite smoothly;

1. Application Button → Export → FBX.
2. Open Showcase and on the New Scenes tab click on the More pull up.
3. Select the template you want to use.
4. Click on the Revit icon to the right and browse for the FBX file and click Open.
5. Click the Import button and you are ready to get started.

There is a range of template options that can be selected during the import process. These set the lighting and background of your scene, amongst other things. Showcase is designed to present your model in a visually appealing manner whilst allowing real-time navigation. The interface is somewhat familiar with the steering wheel and viewcube present and very easy access to the ‘simple to use’ toolset. There is a guided task wizard to get you up and running quickly. There are several visual styles available for you to choose from, ranging from non-photorealistic renders, through to full ray tracing. Changing between styles is as easy as pressing a button.
You can easily create new views including images, renderings, movies or interactive presentations. Cross sections can also be created and transitions between shots can be animated.

While the application is easy to use, the visual style isn't as polished as what you see on software like Twinmotion 2 or various gaming engine based real-time alternatives. The lighting flares and glow, and subtle depth of field make for very pleasant viewing, but remember that Showcase is bundled in the Building Design Suite.

It is useful as a real-time viewer (depending upon the project and the client), but also great for thrashing out design ideas. This is where the materials options tool becomes very valuable with its simple to use buttons. You can scroll through a range of options quickly and easily. That, combined with the presentation features, makes this a great tool for client meetings.

Check out the sample video.

The end result of Showcase is somewhere between Revit and 3ds Max. The graphics are no match for Max, so until Max's real-time engines improve, it fills the gap in the product lineup. A free Showcase viewer is downloadable from the web, which allows you to view and navigate the scene without the need for a full version of the software to be installed.
8. **Autodesk® 3ds Max® Design**

Whilst Revit has capable rendering abilities it cannot rival 3ds Max Design for speed and quality (in the right hands). It is a very complex application and is not for the faint hearted, as it will take a lot of effort to be able to get good results in a timely manner. Don't try and learn the entire program, just focus on the areas you need to get the results you want. There is a lot of help and advice available for 3ds Max and it has really good support communities in place (refer to Resources list); use them!

1. Export an FBX file while in a 3D view (this 3D view will be the only camera exported) - (Application Button → Export → FBX).
2. In 3ds Max Design use the File Link Manager to import FBX files from Revit. Use the preset most suited to your Revit model (Combine By Revit Material, Combine By Revit Family Type, As One Object, etc.).
3. Set incoming file units to inches (even if you work in millimeters – fbx files default to imperial) to ensure the file imports at the correct scale and you don’t have any map scaling issues.
   - Use native max materials (Mental Ray A&D materials are a good starting point) to maximize quality.
   - Render out elements for more control after rendering (refer to Composite section).
   - Make use of features such as Ambient Occlusion passes.
   - Make use of proxies to allow for massive scenes that remain a controllable size (think trees, cars, detailed furniture, etc).

There are several options when it comes to render engines in 3ds Max.

- The original Scanline renderer
- Mental Ray which is a much more complex but also powerful renderer. It allows the use of features such as MR Proxies.
- iray® for simpler configuration (with some limitations) . The easiest to pick up due to limited settings and simpler interface.
- Try Quicksilver for stylized effects, viewed onscreen or rendered out.
If you want to utilize more advanced capabilities then consider learning Mental Ray, but this will require a substantial investment of time. Or if an easier solution is required, then consider iray, as this will provide very convincing images with much less tinkering, but a longer render time.

More tips:

- Consider exporting panoramas (Rendering → Panorama Exporter) to obtain an interactive viewing experience (good for internal rooms).
- Avoid traditional walkthroughs, go for a more creative animation that tells a story.
- Even still images composited together with subtle scaling and movement can look professional.
- Always render out image sequences rather than animation files, and use compositing software to compile it. This way if your render crashes near the end you only lose one frame not a whole animation.
- Use EXR files for output to ensure flexible lighting adjustment (post corrections) and element support, or at least 16bit TIF file types.

For the more advanced, try out the Project Geppetto Technology Preview. Populate scenes with crowds of people quickly and easily. It's only in its early stages, but definitely worth a play.

Finally, look to popular visualization studios for inspiration, or check out the industry awards (www.neoscape.com, www.uniform.net, www.cgarchitect.com/3dawards, etc.).

Autodesk® Composite - its free with 3ds Max, use it! You can really improve your images and animations by using this node based compositing application. Whether it's a last minute change to an element's color, or compositing a complex animation, Composite can be a real time saver that offers you so much more control over your final product.

Composite is best used in conjunction with the EXR file type rendered out of 3ds Max, although you can use most image formats including PNG, TIFF, JPG, etc. EXRs can contain render elements; these are separate elements of a render; Alpha, Lighting, Reflection, Shadow, etc., along with a much wider range of lighting information (up to 32bit opposed to 8bit for JPG). They render during the normal render pass, so add very little overhead to your render time. The additional lighting information is valuable because it allows you to make quite dramatic adjustments to the render's lighting without losing detail or requiring re-rendering of the scene.

Some useful elements to render out for architectural visualization include;

- Alpha – provides transparency information
- Ambient Occlusion – produces shadows in occluded areas
- Lighting – direct and indirect lighting
- Matte – provides masks for selected objects
- Reflection – includes all reflections in the rendering
- Velocity – allows convincing motion blur to be added
- Z-Depth – aids in adding convincing depth of field blur

When combined with the original render, the control available can be utilized to create spectacular images and animations. Typical effects added in Composite often include;

- Basic color correction and grading
- Lighting enhancement, contrast correction, etc.
- Compositing of elements and backgrounds
- Motion blur
- Depth of Field and general softening of image
- Addition of grain, noise, or sharpening, etc.

These can have a significant effect on the perceived quality of your images, and make Composite well worth exploring, especially for the creation of high quality images. Look at this video for a typical step by step process, then check out the link to additional videos in the resources section, and remember to read the help file for more details.
9. 3D Printing

Although this technology has been around for years, not that many architectural firms make use of it. It has the potential to reduce costs (compared with traditional scale models) whilst improving communication with the client. 3D printing can be used to great effect.

You have to do a bit of research before you can actually get a file that the print shop will accept without wanting to charge extra for fixing problems. Whilst there are quite a few options, we generally aim to produce a .stl (stereo lithography) file type for monochrome prints and a .wrl (VRML) file type for color prints.

The STL exporter plugin for Revit was made open source earlier this year and is available for download from: [http://stlexporter.sourceforge.net/](http://stlexporter.sourceforge.net/). It will appear on the Add-Ins tab next time you start Revit.

The main problem with this exporter (in my opinion) is that it doesn't shrink wrap the file, so an export of 580 solids from Revit will yield a file with 580 shells. This then has to be shrink wrapped so that it appears as one single solid item. There are several ways of accomplishing this:

1. Your print shop may provide the service for free (for example, using ZPrint or ZEdit Pro)
2. You can purchase additional software such as CADspan Pro ([http://www.cadspan.com/](http://www.cadspan.com/)) or Magics ([http://www.materialise.com/Magics](http://www.materialise.com/Magics)). It’s worth noting that you can get trial versions to test with your workflow before purchasing.
3. You can alter your workflow by introducing additional Autodesk software.

This workflow consists of exporting from Revit as an ACIS file and taking it into AutoCAD. In practice this technique seems to drop some solids on complex models, but works really well on simpler models.

1. **Revit** → **Application Button** → **Export** → **CAD Formats** → **ACIS (SAT) files**
2. **AutoCAD** → **Insert Ribbon tab** → **Import** → **Browse to file**.
3. From within AutoCAD you can then either export as a .stl via;
4. **Application Button** → **Export** → **Other Formats** → select **Lithography (*.stl)** or via;
5. **AutoCAD** → **Output Ribbon tab** → **Send to 3D Print Service** → (TIP: this option is only available when in a 3D mode, not basic 2D drafting and annotation).
So how do you go about testing these files once you think they are ready? Your 3D print shop would get pretty fed up of looking at one file after another, so your best option is to download a free viewer. There are several options but try MiniMagics (http://www.materialise.com/MiniMagics) for STL viewing:

1. File → Import
2. View the Part Pages to see how many inverted normals and bad edges your file has, whether it consists of more than one shell (= bad, you want it to be a single shell), and if the part is ok for printing.

STL files do not carry any texture information and as such are only suitable for single color printing. For full color and/or textured printing a VRML file (.wrl) is required. Our most successful workflow for this file type is from Revit:

1. Revit Application Button → Export → FBX then file link into 3ds Max Design.
2. 3ds Max Design Application Button → References File → Link Manager → Select file
   Select Preset → (Autodesk Revit FBX – combine by Revit Material).
3. Then bind so that your meshes can be attached to form a single object after texturing.
4. Apply textures using standard materials (not Mental Ray materials) as required, use UVW mapping if necessary.
5. Export as a VRML file type (.wrl extension) Application Button → Export → Export (non-native) → select VRML97(*.WRL).

VRML files can be visually verified with a free plugin such as Cortona 3D (http://www.cortona3d.com/Products/Viewer/Cortona-3D-Viewer.aspx) which uses your internet browser to display the file.
Minimum print resolutions are an important consideration. We prefer to use Z Corporation printers as they offer a good balance between cost and results. With these machines the tolerances you should aim for are nothing thinner than 1 mm for free standing detail elements (internal walls, window frames, etc.), and preferably at least 2 mm thickness for external walls, etc. Try and ensure that all vertical elements such as curtain wall mullions are restrained at the top to add structural integrity to your model. Whilst you won’t be able to just export from your working Revit model, once you have decided on the scale of the model you require, it is easy to do a save as on the model and quickly edit families to ensure that the minimum recommended thickness is met. You will also have to scale your model after export, or at least have the correct sizes to give to your print shop.

Make use of your visibility setting in Revit when exporting. You can easily isolate roofs to obtain separate pieces from the printer. The results can be quite impressive.
10. Autodesk® Revit® Verticals (Architecture, MEP, Structure) and Autodesk® Navisworks® Manage

The three Revit verticals feature specialized tools for the architectural, structural, mechanical, electrical and plumbing disciplines. The majority of features specific to the Revit Structure platform cannot be found in the architectural platform. Having said this, a file created in the structural platform can be opened in the architectural and MEP platforms and vice versa. This allows for the possibility of one central Revit model that contains all AEC consultant information. This is already a realization for multidiscipline practices that share a local area network. For firms that are collaborating with external consultants, a single Revit model is a difficult proposition.

Whilst technologies such as Revit Server are being developed to allow Revit worksharing files to be shared over a wide area network, the majority of consulting architectural and engineering firms are not utilizing these systems yet, this is more common with multidiscipline firms with offices spread over a wide geographic area. Instead, consultants link the other disciplines Revit models into their own Revit file. It is important in these situations to establish a shared coordinate system that can be used amongst all consultants.


One of the most important collaborative tools within Revit, regardless of whether consultants are using a single Revit model or linked models, is the Copy/Monitor tool. This allows professionals of the different disciplines to track the changes that occur in the Revit model during the design process.


It is always good practice to make use of features from the other verticals in your project. An example is ensuring you have the right connectors in the architectural model to allow the MEP model to connect directly to you components, rather than MEP Engineers having to replace them with families that function correctly. If you have access to the Building Design Suite, incorporating this kind of workflow can really benefit your company. Just ask advice from the other disciplines if you are unsure.
For those who are unfamiliar, Navisworks is the collaborative link between the AEC disciplines. Whilst used primarily with AutoCAD and the Revit verticals, Navisworks also allows collaboration between offices who use non-Autodesk software, such as ArchiCAD and Microstation. Navisworks is an incredibly powerful tool that includes features such as clash detection, 4D timeline production and construction simulation.

Whilst Navisworks Freedom allows DWF input from Revit, the best practice for importing information into Navisworks is to utilize an NWC file type. Navisworks Simulate or Manage are required for an NWC import. The Revit NWC exporters are available from the Autodesk website and are also included during a Navisworks Simulate or Manage installation.

1. Add-Ins Ribbon Tab → External Tools → Navisworks 2012 (or other version)
2. Click Navisworks settings… to change your export settings.
3. Specify your export options as required for your project. Spend time customizing these fields to meet your company standards. (Most importantly, you can find the tick box to export linked Revit files.
4. On this screen you can export your settings to an .XML file for future use or also import a previous .XML file

A new feature in Navisworks 2012 is the switchback feature (also found on the Add-Ins Ribbon Tab in Revit). When both Revit and Navisworks are open simultaneously you can select an element, and upon clicking the button, the same element will be selected in the other program. This allows you to highlight elements in any of the Revit verticals whilst detecting clashes or even just exploring the 3D model.

The key to successful use of Navisworks for the purpose of clash detection lies in making good use of settings within the Clash Detective. Break tests down into Batches so they are easier to
manage, set the *Rules* carefully to avoid unnecessary hits, select limited elements breaking the testing into bite sized chunks. This is simplified with the use of *Selection* and *Search Sets*. When reviewing the *Results*, make good use of groups to eliminate the need to deal with duplicate clashes.

There are some really good classes right here at AU on Navisworks, ranging from introductions through to advanced simulations. Check them out!
11. Project Dasher

Simply put, Project Dasher is the future for building performance monitoring. It is only logical for construction models to be refined to ‘as built’ models during construction and to then be handed on to FM for use throughout the lifecycle of the building. It is only a matter of when, not if, building owners will be requesting our BIM models as a deliverable. While this may already be the case on some projects, it’s not until something like Project Dasher really penetrates the market that we will see this become mainstream.

The ability to monitor the performance of a building is something that could have a significant impact on the way we design too. Being able to obtain data that designers can reflect upon and learn from will influence the design process itself. Not to mention the efficiencies that could be obtained and verified by building operators. Revit models are going to play an important part in the management of buildings going forward.

There are several alternative products on the market. One of the more popular options is FM:Systems. They have a BIM Integration Component that interacts directly within Revit. Other examples include EcoDomus and the Onuma System.

Just as the governments of the world have recognized the benefits that BIM can bring to construction, it is only a matter of time until their drive for lower carbon footprints will trigger a requirement for all large new builds to employ a technology driven FM solution.

Conclusion

The aim of this lecture is to introduce the possibilities available to you, providing options of how to maximize your deliverables by utilizing your existing Revit data. The purpose is to point you in the right direction to get started. Hopefully you will have encountered some useful information about the various applications and this will generate enough interest to prompt you into action. I’m the first to admit that there are many ways to get your data from A to B and each method has its benefits and draw backs. Whilst the methods put forward may not be the most common or right techniques, they are generally the solution that worked best for us!

The next step is up to you. Decide which applications you are going to trial and read the resources provided. Continue further research on your new application to enable you to work effectively and efficiently. To achieve this you need to have a very thorough understanding of the software interface and its capabilities. I cannot stress this enough - you are much better off writing off a few hours studying the documentation and user interface, than wasting a whole day trying to get a real project up and running, unsuccessfully!

Enjoy life after Revit, and good luck experimenting.
Application Links

(refer to links within text first)

Autodesk //Labs_: http://labs.autodesk.com/aec/

Autodesk Research: http://www.autodeskresearch.com/projects/

Building Design Suite:
http://usa.autodesk.com/adsk/servlet/cp/index?siteID=123112&id=16406616

Green Building Studio®:
http://usa.autodesk.com/adsk/servlet/cp/index?id=11179508&siteID=123112

Ecotect® Analysis: http://usa.autodesk.com/adsk/servlet/cp/index?id=12602821&siteID=123112

Navisworks® Manage: http://usa.autodesk.com/navisworks/

Impression: http://usa.autodesk.com/adsk/servlet/cp/index?id=9246650&siteID=123112

Showcase®: http://www.autodesk-showcase.com/

3ds Max® Design: http://usa.autodesk.com/3ds-max/

Project Dasher: http://www.autodeskresearch.com/pages/dasher

Resources

Project Mosaic http://mosaic.autodesk.com/

Autodesk University http://au.autodesk.com/

Autodesk WikiHelp http://wikihelp.autodesk.com/enu

Revit Help http://wikihelp.autodesk.com/Revit/enu/2012

Autodesk Discussion Groups http://forums.autodesk.com/

AUGI Forums http://www.augi.com/forum/

Revit forums http://www.revitforum.org/forum.php

Linkedin Groups: Revit Users, Autodesk Labs, AU, AUGI, etc.

Sustainable Design Blog http://thesustainabledesigntoolbox.typepad.com/blog/
Architectural Visualization forums http://www.cgarchitect.com/
Mental Ray Material downloads http://www.mrmaterials.com/
3ds Max Tips blog http://jamiesjewels.typepad.com/
Mental Ray and iRay tips http://jeffpatton.net/
Autodesk Area http://area.autodesk.com/
iRay videos http://www.youtube.com/results?search_query=autodesk+3ds+max+iray&aq=o
Composite videos http://www.youtube.com/results?search_query=autodesk+composite&aq=f